NOTICE

Mutoh reserves the right to modify the information contained in this user manual at any time without prior notice; unauthorized modification, copying distribution or display is prohibited. All comments, queries or suggestions concerning this manual please consult with your local dealer.
Thank you for purchasing the **ValueCut Cutting Plotter**. Before you use the cutting plotter, please make sure that you have read the safety precautions and instructions below.

**Caution**

**SAFETY PRECAUTIONS!**

- For safety concern, please always hold the cutter firmly **from the bottom** while moving it. Do not move the cutter by clasping the depression area on both sides.

  ![Correct](image1.png) ![Incorrect](image2.png)

  **O** (Correct)  **X** (Incorrect)

- Do not place your hand close to the tool carriage to prevent your fingers from being clamped during the operation of the cutting plotter.
Hazardous moving parts keep fingers and other body parts away!

**WARNING**
HAZARDOUS MOVING PARTS
KEEP FINGERS AND OTHER BODY PARTS AWAY

- Do not shake or drop the blade holder, a blade tip can fly out.
- During an operation, do not touch any of the moving parts of this machine (such as the carriage). Also be careful to make sure that clothing and hair do not get caught.
- Always connect the power cable to a grounded outlet.
- Always use the accessory power cable which is provided. Do not wire the power cable so that it becomes bent or caught between objects.
- Do not connect the power cable to branching outlet to which other machines are also connected, or use an extension cable. There is danger of overheating and of mis-operation of the machine.
- Keep the tools away from children where they can reach.
- Always put the pinch rollers within the white marks.

**Note:** Never press the top release grip (the release grip is fully pressed when a clip sound is heard) and pull the bottom release grip at the same time as the pictures shown below. This will prevent you from disabling the pinch roller as the stop bar will not reach the correct position and therefore will not be functioning.

**O (CORRECT)  ✗ (INCORRECT)**

Press down

Press down

DISABLE  Stop bar
Pull up bottom to release grip
# Table of Contents

## Important Information

## 1. General Information
- 1.1 Introduction
- 1.2 Package Items
- 1.3 Product Features
- 1.4 Appearance of ValueCut
  - 1.4.1 The Front View
  - 1.4.2 The Back View
  - 1.4.3 The Whole View
  - 1.4.4 The Left-hand Side
  - 1.4.5 The Right-hand Side

## 2. Installation
- 2.1 Precaution
- 2.2 Stand & Flexible Media Support System
- 2.3 Desktop Flexible Media Support System
- 2.4 Installation of Media Basket System
- 2.5 Cutting Pad Installation
- 2.6 Blade Installation
- 2.7 Automatic Blade Length Detection
- 2.8 Cable Connections
  - 2.8.1 USB Interface
  - 2.8.2 Driver Un-installation
  - 2.8.3 RS-232 Interface
  - 2.8.4 Data Transmitting

## 3. The Control Panel
- 3.1 The LCD Panel
- 3.2 Menu in On-line Mode
- 3.3 Menu in Off-line Mode
- 3.4 Menu Items

## 4. Operation
- 4.1 Media Loading
  - 4.1.1 Loading the Sheet Media
  - 4.1.2 Loading the Roll Media
- 4.2 Tracking Performance
- 4.3 Cutting Force and Offset Adjustment
- 4.4 How to Cut 3mm Letter
- 4.5 How to Make A Long Plot
- 4.6 When Completing the Cutting Job
- 4.7 ValueCut Print Driver setting
  - 4.7.1 Option Page
  - 4.7.2 Paper Page
5. Automatic Aligning System
   5.1 Introduction 5-1
   5.2 Calibrating the System 5-2
      5.2.1 Media Calibration 5-2
      5.2.2 AAS Calibration 5-2
      5.2.3 AAS II on ValueCut 5-3
      5.2.4 Automatic Distinction of the Plot Direction 5-5
   5.3 Printer Test 5-5
   5.4 Registration Mark Offset Range 5-7
   5.5 Contour Cutting 5-7
   5.6 Tips for AAS 5-9

6. Maintenance
   6.1 Cleaning the cutting Plotter 6-1
   6.2 Cleaning the Grid Drum 6-2
   6.3 Cleaning the Pinch Rollers 6-2

7. Trouble Shooting
   7.1 Non-Operational Problems 7-1
   7.2 Operational Problems 7-2
      7.2.1 LCM Error Messages 7-2
      7.2.2 Other operational problems 7-3
   7.3 Cutting Plotter/Computer Communication Problems 7-5
   7.4 Software Problems 7-6
   7.5 Cutting Quality Problems 7-7

Appendix
   A-1 ValueCut Specification A-1
   A-3 Consumable and Optional Item List A-3
   A-4 CorelDRAW Plug-In Instruction A-4
   A-5 Illustrator Instruction A-5
1. General Information

1.1 Introduction
ValueCut series cutting plotters have been designed to produce computer-generated images or perform contour cutting on sheets or rolls of vinyl media.

This manual covers the following models of ValueCut series cutting plotters:

<table>
<thead>
<tr>
<th>Model</th>
<th>Media Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC-600</td>
<td>50mm (1.97”) ~ 770mm (30.3”)</td>
</tr>
<tr>
<td>VC-1300</td>
<td>50mm (1.97”) ~ 1594mm (62.7”)</td>
</tr>
<tr>
<td>VC-1800</td>
<td>300mm (11.8”) ~ 1900mm (74.8”)</td>
</tr>
</tbody>
</table>

1.2 Package Items
The package of the ValueCut model contents the items listed below, please check carefully. If you find any item missing, please consult your local dealer for further assistance.

<table>
<thead>
<tr>
<th>Standard Item</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Cutting Plotter</td>
<td>1</td>
</tr>
<tr>
<td>2. Stand Set (for VC-1300/1800 only)(Optional for VC-600)</td>
<td>1</td>
</tr>
<tr>
<td>2 piece of T-shape stand</td>
<td>1</td>
</tr>
<tr>
<td>1 piece of stand beam</td>
<td>V</td>
</tr>
<tr>
<td>18 pieces of M6 screws</td>
<td>V</td>
</tr>
<tr>
<td>1 piece of M5 L-shape hexagon screw driver</td>
<td>V</td>
</tr>
<tr>
<td>1 piece of Installation Guide for Stand Set</td>
<td>V</td>
</tr>
</tbody>
</table>

3. Flexible Media Support System Package

<table>
<thead>
<tr>
<th>Items</th>
<th>VC-1300/1800 Only</th>
<th>VC-600</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 set of Roll Media Flange (2 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 set of Roll Holder (2 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 set of Roll Holder Guide Bushes (4 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 set of Roll Holder Support (2 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 piece of M6 L-shape hexagon screw driver</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 piece of Installation Guide for Roll Holder</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>1 piece of M5 L-shape hexagon screw driver</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>1 set of Desktop Support Brackets (2 pieces)</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>4 pieces of Plastic Foot</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>4 pieces of M4 screws</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>12 pieces of M6 screws</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>1 piece of M4 L-shape hexagon screw driver</td>
<td>V</td>
<td></td>
</tr>
</tbody>
</table>
4. Accessories

- 1 piece of User’s Compact Disk
- 1 piece of data cable (RS-232C)
- 1 piece of data cable (USB cable)
- 1 set of Blade Holder Assembly (Installed in tool carriage of the cutting plotter)
- 1 piece of Blade (45° with Red Cap/ Installed in Blade Holder)
- 1 piece of Safe Blade
- 1 piece of Cutting Pad for Vinyl cutting
- 1 piece of Tweezers
- 1 Oily ball-point pen

1.3 Product Features

The following are the main features of the ValueCut series cutting plotters:

- Tri-port connectivity provides you with greater flexibility
- Up to 600-gram cutting force
- Up to 60-inch/per second cutting speed
- Guarantee 10-meter tracking
- User friendly, multi-language control panel
- Ingenious media basket (optional item)
- Enhanced Automatic Aligning System for automatic contour cutting
1.4 Appearance of ValueCut

1.4.1 The Front View (Figure 1-1)

**Grid Drums** – move the media back and forth during operation.

**Tool Carriage** – performs the cutting with the installed blade and pen with AAS module.

**Control panel** – consists of 14 control keys and 1 LED and 1 LCM showing messages and menus.

**Slicer Groove** – slice off the extra media easily along this groove.

**Alignment Rulers** – media can be aligned with the clear guide line marks.

**Platen** – provides the surface for holding and supporting media while performing cutting.

**Cutting Pad** – provides the protection of blade when the blade is cutting.

**Lever** – raises or lowers the pinch rollers.

**Pinch Rollers** – hold the media during cutting.

1.4.2 The Back View (Figure 1-2)
The Whole View of ValueCut (Figure 1-3)

**Roll Holder** – holds and supplies the roll media for cutting.

**Roll Holder Guide**
**Bushes** – serve to keep the roll media in place when media is pulled from the roll.

**Stand Beam** – stabilizes the body.

**Roll Holder Support** – supports roll holders.

**T-Stand** – supports the cutting plotter.
1.4.4 The Left-hand Side (Figure 1-4)

- Power Switch – On when switches to ‘[I]’; Off to ‘[O]’
- Fuse – 3 Amp.
- AC Power Connector – used to insert the AC power cord.

![Figure 1-4](image)

1.4.5 The Right-hand Side (Figure 1-5)

- Serial Interface Connector (RS232C) – used to connect the cutting plotter to a computer through a serial interface cable.
- USB Connector – used to connect the cutting plotter to a computer through a USB cable.

![Figure 1-5](image)
2. Installation

2.1 Precaution

Please read the following information carefully before you start installation.

**Note:**

1. Make sure the power switch is off before installing the cutting plotter.
   Carefully handle the cutter to prevent any injuries.

2. **Choosing a proper place before setting up the cutting plotter**

Before installing your cutting plotter, select a suitable location, which meets the following conditions.

- The machine can be approached easily from any direction.
- Keep enough space for the machine, accessories and supplies.
- Keep the working area stable, avoiding severe vibration.
- Keep the temperature between 15 and 30°C (60-86°F) in the workshop.
- The relative humidity of the working environment should be between 25% to 75%.
- Protecting the machine from dust and strong air current.
- Preventing the machine from direct sunlight or extremely bright lighting.

3. **Connecting the Power Supply**

Check the plug of the power cord to see if it matches with the wall outlet. If not, please contact your dealer.

- Insert the plug (male) into a grounded power outlet.
- Insert the other end (female) of power cord into the AC connector of cutting plotter.
2.2 Stand & Flexible Media Support System (for VC-1300/1800)

Step 1
Please examine supplied items in the accessory box of stand carton:
- 2 pieces of base beams
- 2 pieces of side beams
- 1 piece of stand beam
- 20 pieces of M6 screws
- 1 piece of M5 L-shape hexagon screw driver
- 1 piece of Installation Guide for Stand Set

Step 2
- Remove the plotter body and the accessories from the shipped carton.
- Assemble the base beam to the side beam with 2 screws to form a T-shape stand. (See Figure 2-1)

Please pay attention to the direction of the base beam (the wheel on the front end of the beam comes with a break while the rear one is on its own).
**Step 3**
Place the stand beam upright on the T-stand and follow number 1 2 to assemble. (See Figure 2-4 & 2-5)

![Figure 2-4](image)

**Step 4**
Position the stand beam perpendicularly to part 1 and put the screws into the holes and tighten them as Figure 2-5. Then the complete picture of stand will be like Figure 2-4.
Step 5
Remove the cutting plotter from the carton. Position your stand under the plotter, and then insert the screws into the holes on plotter’s bottom and tighten them up as shown in Figure 2-6.

Figure 2-6

Note: The cutting plotter needs to be assembled by at least two people.
Step 6
Insert the roll holder support with the screws into the holes of the stand, and then tighten them up as shown in Figure 2-7. You could decide roll holder support’s position by inserting into different holes.

![Figure 2-7](image)

Step 7
Place two roll holders into the holes in the roll holder support. (Figure 2-8)

![Figure 2-8](image)
Step 8
Lastly, the complete picture will be shown like below. (Figure 2-9)

Figure 2-9
2.3 Desktop Flexible Media Support System (For VC-600 only)

**Step 1**
Please examine the following items in stand carton’s accessory box:
- 1 set of Roll Media Flange (2 pieces)
- 1 set of Roll Holder (2 pieces)
- 1 set of Roll Holder Guide Bushes (4 pieces)
- 1 set of Roll Holder Support (2 pieces)
- 1 set of Desktop Support Bracket (2 pieces)
- 4 pieces of Plastic Foot
- 4 pieces of M4 screws
- 12 pieces of M6 screws
- 1 piece of M4 L-shape hexagon screw driver
- 1 piece of M5 L-shape hexagon screw driver
- 1 piece of M6 L-shape hexagon screw driver (for adjusting the screws of Roll Holders)
- 1 piece of Installation Guide for Roll Holder

**Step 2**
Put the 4 Plastic Foot under the Roll Holder Support and insert the M4 screw into the hole of Plastic Foot and tighten them with the M4 L-shape screw driver. (Figure 2-7)
Step 3  Position the Desktop Support Brackets beside the Roll Holder Support and insert M6 screws into the Roll Holder Support and tighten them with M6 L-shape screw driver. (Refer to Figure 2-9 at the left).

Step 4  Put the bottom of machine in lateral, and position the Roll Holder Assembly beside the bottom of the machine. Then, insert the M6 screws into the holes of Roll Holder support assembly and tighten them with M6 L-shape screwdriver. Like Figure 2-10.

Step 5  Place the two roll holders into the holes of Roll Holder Support (Figure 2-10).

Step 6  The complete Desktop Media Support System will be shown as in Figure 2-11.
2.4 Installation of Media Basket System

**Step 1**
Please examine the supplied items in the accessory box
- 2 pieces of basket arms
- 2 pieces of basket rods
- 1 piece of basket
- 2 pieces of fixtures (for basket arms)
- 8 pieces of M3 screws
- 1 piece of 2mm L-shape hexagon screw driver

**Step 2**
First, place the basket arms beside the stand and fix them with fixtures. Then insert the M3 screws and tighten them with the 2mm L-shape screw driver. (See Figure 12)
**Step 3**
Insert the basket rods to the basket holes (See Figure 13)

**Figure 2-13**

**Step 4**
Loosen the basket screws from the basket arms. Position the basket rod in front of the basket arms and insert the basket screws into the holes on the basket rod and tighten them. (Figure 14)

**Figure 2-14**
Step 5
The complete Media Basket System will be like Figure 2-15.
2.5 Cutting Pad Installation
1 piece of cutting pad is included in the accessory pack. Follow the instruction below to install a new cutting pad when the existing pad is worn out.

**Step 1**
Carefully remove the cutting pad from the unit.

![Figure 2-16](image)

**Step 2**
Remove the remaining adhesive on the groove with alcohol or cleaning naphtha.

Remaining adhesive

![Figure 2-17](image)
Step 3
Attach the new cutting pad to the groove after unrolling it and removing the backing sheet and the installation process is completed.

Figure 2-18

Figure 2-19
2.6 Blade Installation

Figure 2-20 is the illustrator of the blade holder. Insert a blade into the bottom of the blade holder and remove the blade by pushing the pin. Make sure that your fingers are away from the blade tip.

**Step 1**
Install blade (Figure 2-21).

**Step 2**
Push the blade to the bottom of the blade holder. (Figure 2-22).

**Step 3**
Adjust the blade tip to suitable length by screwing “Blade tip adjustment screw” clockwise or count-clockwise. (Figure 2-23).

**Tips:**
“The proper length” means the blade’s length is adjusted 0.1mm more than film’s thickness. That is, if the thickness of film is 0.5mm, then blade’s length is properly adjusted 0.6mm and it can completely cut through the film layer yet avoid penetrating the backing.
Step 4
Insert the blade holder into tool carriage. Please note the outward ring of the holder must put into the grooves of carriage firmly (see Figure 2-24), then fasten the case (Figure 25).

Step 5
Use the reversing steps to remove the blade holder.

Step 6
Eject the blade. Push “Blade eject pin” to eject blade when the blade needs to be replaced.

Note:
The blade will lose its sharpness after a period of usage, the cutting quality might be affected. By increasing the cutting force, it might do the trick. However, once the blade is worn out and no longer provides a reliable cutting, you should replace a new one. The blade is consumable and must be replaced as often as necessary to maintain the cutting quality. The quality of the blade deeply affects cutting quality. So be sure to use a high quality blade to ensure good cutting results.
2.7 Automatic Blade Length Detection

Figure 2.26 is the new blade holder with a scale and the carriage with a mark. This blade holder detects blade length automatically and shows how the knob needs to be turned on the LCM.

There are 10 units on the scale; each unit equals to 0.05 mm, allowing you to adjust the blade length for 0.00mm-5.00mm (Figure 2-26).

Follow the steps below to adjust the length of the blade:

1. Keep the blade tip within the blade holder before you start adjusting.
2. Align one of the scales on the blade holder to the mark on the carriage
3. Select “Blade Length Adjust” under “CUT TEST” on the LCM, enter the blade length wished in “Set Length”; test the blade holder first and then test the blade length by pressing ENTER.

Note:
Keep the blade holder at the same position when you perform blade holder and blade length tests.
4. When blade holder and blade length tests are finished, the screen will show you to what degree (the unit of the value following “CW” or “CCW” is “circle”) and in which direction [CW (clockwise) or CCW (counterclockwise)] you should turn the adjustment knob. EG, Turn CW 5 is telling you that you should turn the knob for 5 units clockwise (Figure 2-28, Figure 2-29).

5. The screen will show "Adjustment completes" when the value on the screen is 0, the blade length is perfect and no more adjustment needs to be made. Press "Enter" now to complete the process and you may start cutting at this point.
2.8  Cable Connection

The cutting plotter communicates with a computer through a **USB (Universal Serial Bus)**, **Parallel port (Centronics)**, or a **Serial port (RS-232C)**. This chapter shows you how to connect the cutting plotter to a host computer and how to set up the computer/cutting plotter interconnection.

**Note:**
When USB connection is enabled, both parallel port and serial port will be disabled automatically.

---

2.8.1  USB Interface

ValueCut build-in USB interface are based on the Universal Serial Bus Specifications Revision 1.1. (Operation system of Windows 95, Windows NT don't support USB ).

- USB driver installation

**Note:**
If you are using Windows 2000 / XP / Vista / 7 as your operating system, make sure you log in using the “Administrator” account.

Use the USB One-click Installation for quick driver installation. Follow the simple steps below for driver setup.
Step 1:
Connecting your Mutoh cutter
1. Turn on the machine.
2. Connect the USB connector to the machine and then USB driver will installed automatically. It will take a few minutes to find the device. Please DO NOT disconnect the USB cable until the installation has completed.
3. You can double click the USB icon on the taskbar to make sure the USB device is detected.

Step 2: Installing the software
(1) Put the installation CD into your CD-ROM. Please make sure that the USB device is connected before you start the driver installation.

(2) Choose either the 32 bit or 64 bit driver installation depending on the operating system installed on your computer to start the installation.
(3) Click “Next” to start the driver installation.

(4) The installation will take a few minutes to complete and you will see a message below and click on “OK” upon completion. Enjoy your Mutoh cutter!
2.8.3 Driver Un-installation
You have to remove previous version driver installed on your PC system completely before you can install the latest version successfully. Please refer to below steps.

1. Right click on the printer to remove the printer from system Printer page.

2. After remove from the ValueCut unit, right click on any empty space on the page and select “Server Property”

Note:
(1) If the driver is being installed for a second time, the user will be prompted as to whether a second copy of the driver installation is required.

![Driver Installation Warning]

The VC-1300 driver installed.
Do you want add attachment?
Yes  No
3. The Control Panel

This chapter describes the button operations with the LCM menu flowcharts of ValueCut. When the cutting plotter is ready for use as described in Chapter 1 & 2, all functions are under default parameters.

3.1 The LCD Panel

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD Screen</td>
<td>To display functions and error messages.</td>
</tr>
<tr>
<td>Power LED</td>
<td>To indicate the power status (light up: power on; light off: power off)</td>
</tr>
<tr>
<td>4 Arrow Keys</td>
<td>To move position, select function, or change setting.</td>
</tr>
<tr>
<td>ENTER</td>
<td>To set item or register the immediately preceding input value.</td>
</tr>
<tr>
<td>PAUSE/RESUME</td>
<td>To temporarily halt cutting process or to continue</td>
</tr>
<tr>
<td>ON/OFF LINE</td>
<td>To switch modes, stop cutting job, or abort changes of settings.</td>
</tr>
<tr>
<td>OFFSET</td>
<td>To adjust the value of blade’s offset.</td>
</tr>
<tr>
<td>FORCE</td>
<td>To adjust the value of cutting force.</td>
</tr>
<tr>
<td>SPEED</td>
<td>To adjust the value of cutting speed and quality.</td>
</tr>
<tr>
<td>CUT TEST</td>
<td>To perform cutting tests in different ways.</td>
</tr>
<tr>
<td>DATA CLEAR</td>
<td>To clear up buffer memory.</td>
</tr>
<tr>
<td>TOOL SELECT</td>
<td>To select tools.</td>
</tr>
<tr>
<td>MISC</td>
<td>To set up functions.</td>
</tr>
</tbody>
</table>

Please see details in “3.4 Menu Items”
3.2 Menu in On-line Mode

**Power On**  ValueCut in processing

- **ValueCut Cutter**
- **LCM Version:** "- - -"

- **ValueCut**
  - **Firmware:** "- - -"
  - **Copyright:** "- - -"

- **Place Media And Then Lower Down The Lever**
  - **Roll:** △
  - **Edge:** ▼
  - **Single:** ▶

- **Sizing Media Width Lever Up**
  - **To Abort**

- **Sizing Media Length Lever Up**
  - **To Abort**

- **Top menu**
  - **S--- F----- O----**
  - **L-------- W----- T1M**

- **Sending data**
  - **Pause**
  - **Setup**
  - **Resume**
  - **[PAUSE ]**

- **[FORCE]
  - Force: 80 gf
  - OK: ENTER

- **[SPEED]
  - Speed: 72 cm/s
  - Select: △
  - OK: ENTER

- **[OFFSET]
  - Offset: 0.275 mm
  - OK: ENTER

- **[DATA CLEAR]
  - Clear Data Memory
  - N: Cancel
  - OK: ENTER

- **[TOOL SELECT]
  - 1S:72 F:80 O:0.275 M
  - Select: △
  - OK: ENTER

  - Set Smoothing Cut
    - Select: △
    - OK: ENTER

  - OverCut
    - Select: △
    - 0.00 mm
    - OK: ENTER

  - Set Tangential Mode
    - Select: △
    - OK: ENTER

  - Pouncing
    - Select: △
    - 0 mm
    - OK: ENTER

- **Use △ ▼ ▶ to select; [ENTER] to enable the setting**
3.3 Menu in Off-line Mode

Press [ON/OFF LINE] to switch to the offline mode

**Offline For System Setup**

- **[FORCE]**
  - Force: 80 gf
  - OK: ENTER
  - 5~600 with an increment of 5(gram force)

- **[OFFSET]**
  - Offset: 0.275 mm
  - OK: ENTER
  - 0.000~1.000 with an increment of 0.025(mm)

- **[DATA CLEAR]**
  - Clear Data Memory
  - N: Cancel
  - OK: ENTER

- **[SPEED]**
  - Speed: 72 cm/s
  - Select: 
  - OK: ENTER
  - Speed: 3~153 with an increment of 3(cm/s)

  - UP Speed: 72 cm/s
  - Select: 
  - OK: ENTER
  - UP Speed: 3~153 with an increment of 3(cm/s)

  - Quality: normal
  - Select: 
  - OK: ENTER
  - Draft, Fair, Normal, Fine, Small Letter

**[CUT TEST]**

- Square Cut
  - Select: 
  - OK: ENTER

- Repeat AAS Job
  - Select: 
  - OK: ENTER

- Repeat Last Plot
  - Select: 
  - OK: ENTER

- Pattern Setting
  - Select: 
  - OK: ENTER

- Ratio Setting
  - Select: 
  - OK: ENTER

- Blade Length Adjust
  - Select: 
  - OK: ENTER

- Pattern: Arrow
  - Change: 
  - OK: ENTER

- Ratio: 100%
  - Change: 
  - OK: ENTER

- Pattern: Cross, Arrow

- Test Blade Holder
  - OK: ENTER

- Test Blade Length
  - OK: ENTER

- Set Length: 0.00mm
  - Change: 
  - OK: ENTER

- Turn CW, Turn CCW
The Control Panel

1. **Offline For System Setup**
   - Select: ▲▼
   - OK: ENTER
   - Save parameter
   - Select: ▲▼
   - OK: ENTER
   - Restore default
   - Select: ▲▼
   - OK: ENTER
   - Panel Setup
   - Select: ▲▼
   - OK: ENTER

2. **[TOOL SELECT ]**
   - Pouncing
   - Select: ▲▼
   - OK: ENTER
   - 0 mm

   - Set Tangential Mode
   - Select: ▲▼
   - OK: ENTER

   - OverCut:
   - Select: ▲▼
   - OK: ENTER
   - 0.00mm

   - Set Smoothing Cut
   - Select: ▲▼
   - OK: ENTER

3. **[ MISC ]**
   - Auto Unrolled Media
   - Select: ▲▼
   - OK: ENTER

   - Scale Width
   - Select: ▲▼
   - OK: ENTER

   - Scale Length
   - Select: ▲▼
   - OK: ENTER

   - Select Unit
   - Select: ▲▼
   - OK: ENTER

   - Select Language
   - Select: ▲▼
   - OK: ENTER

   - Firmware: x.x.xx
   - FPGA: V.x.x mm/dd/yy

   - Set Communication
   - Select: ▲▼
   - OK: ENTER

   - Paper Saving Mode
   - Select: ▲▼
   - OK: ENTER

   - AAS Offset
   - Select: ▲▼
   - OK: ENTER

   - First back to origin
   - Select: ▲▼
   - OK: ENTER

   - Vacuum
   - Select: ▲▼
   - OK: ENTER

   - Use ▲▼ to select from 1S to 4S; [ENTER] to adjust the parameters

   - Pouncing: 0-200mm with an increment of 1mm

   - OverCut: 0.00-1.00mm with an increment of 0.05mm

   - Metric (cm/gf) or English measurement (inch/oz)

   - Both Expanded Mode、Length Expanded Mode、Width Expanded Mode、Both Unexpanded Mode

   - Enable, Disable

   - Panel Setup
   - Select: ▲▼
   - OK: ENTER

   - Language
   - Select: ▲▼
   - OK: ENTER

   - Both Expanded Mode、Length Expanded Mode、Width Expanded Mode、Both Unexpanded Mode

   - Metric (cm/gf) or English measurement (inch/oz)

   - Enable, Disable
### 3.4 Menu Items

Below describes the functions of menu items

<table>
<thead>
<tr>
<th>Menu or Key</th>
<th>Function</th>
<th>Setting</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>--- Media sizing ---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place Media And Then Lower Down The Lever</td>
<td>To instruct the user to lower the lever after the material is loaded. When the medium is loaded, the user will be requested to lower the lever; once the lever is lowered, users can proceed to the three sizing modes (Roll/Edge/Single).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roll</td>
<td>To measure media width.</td>
<td>Maximum Tracking 150 meters</td>
<td></td>
</tr>
<tr>
<td>Edge</td>
<td>To measure media width and pull the media back till the front paper sensor open.</td>
<td>Maximum Tracking 150 meters</td>
<td></td>
</tr>
<tr>
<td>Single</td>
<td>To measure media width and length.</td>
<td>Maximum Tracking 10 meters</td>
<td></td>
</tr>
<tr>
<td>--- POWER ---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>To indicate the power status.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ Arrow Keys ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td>To move the tool carriage position on X or Y axis.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>To select functions or change values of settings.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ ENTER ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td>The displayed parameters will be saved automatically.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>To set a new origin at the present tool carriage position.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>In “offline” mode, moving the tool carriage to desired position by [Arrow Keys], then press [ENTER] key to set a new origin. While moving with the parameters of XY-axes displayed, press [MISC] key will enable fine-tune movement; press [MISC] key again to disable the function.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ PAUSE/RESUME ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To temporarily halt the cutting process.</td>
<td>To resume the process by press [Pause/Resume] key again.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ ONLINE/OFFLINE ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td>To switch between online mode and offline mode.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>To stop the cutting job or abort the change of setting.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Once press this key, the cutting job will be terminated immediately and cannot be resumed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ OFFSET ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To set or modify the distance between the blade tip and the center axis. Please refer to section 4.3 or Chapter A-2 for more information.</td>
<td>0.000~1.000mm</td>
<td>0.275mm</td>
<td></td>
</tr>
<tr>
<td>[ FORCE ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To set or modify the value of tool force. When the cutting force exceeds 450g, the maximum cutting speed would be 15cm/sec and the cutting quality would be Small Letter Mode (0.2g) and while the cutting force is 300g-449g, the maximum cutting speed would be 30 cm/sec and the cutting quality would be Fine Mode (0.5g))</td>
<td>5~600gram; 5 gram/per step</td>
<td>80 gram</td>
<td></td>
</tr>
<tr>
<td>[ SPEED ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Speed</td>
<td>To set or modify tool down speed at horizontal moving.</td>
<td>3~153cm/sec; 3cm/sec per step</td>
<td>72cm/sec</td>
</tr>
</tbody>
</table>
### The Control Panel

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Range/Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Up Speed</strong></td>
<td>To set or modify tool up speed at horizontal moving.</td>
<td>3~153cm/sec; 3cm/sec per step</td>
</tr>
<tr>
<td><strong>Cutting Quality</strong></td>
<td>To set or modify cutting quality.</td>
<td>Draft, Fair, Normal, Fine, Small Letter</td>
</tr>
<tr>
<td></td>
<td>While cutting small letter, set as “Small letter”.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>While cutting in high speed, set as “Draft”.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For normal operation, set as “Normal”.</td>
<td></td>
</tr>
<tr>
<td><strong>Square Cut</strong></td>
<td>To perform a cutting test at present blade position.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information, please refer to “4.3 Adjusting the Cutting Force and Offset” to adjust blade force and cutting speed.</td>
<td></td>
</tr>
<tr>
<td><strong>Repeat AAS Job</strong></td>
<td>To repeat AAS jobs automatically without having to operate on the computer side.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Please be noted that this feature is mainly applied to the Single paper mode; please ensure a new piece of material you wish to apply this feature on is loaded and the origin repositioned to the first registration mark before starting. When the first AAS job repeat completes, the user will be offered the choice of “Repeat AAS Job Again”, please press “Online/Offline” to return to the main menu.</td>
<td></td>
</tr>
<tr>
<td><strong>Repeat Last Plot</strong></td>
<td>Recut: To repeat the last job without re-sending the data.</td>
<td>1~99; 1 per step</td>
</tr>
<tr>
<td></td>
<td>Copy: To copy the last job without re-sending the data.</td>
<td>1~99; 1 per step</td>
</tr>
<tr>
<td></td>
<td>* 1mm gap will be auto-generated between 2 copies).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* If the media length is not enough to continue, it will show below message on LCM:</td>
<td>Out Of Space; # of Copies finished</td>
</tr>
<tr>
<td></td>
<td>* If both functions are enabled at the same time, the cutter will perform the last setting only.</td>
<td></td>
</tr>
<tr>
<td><strong>Pattern Setting</strong></td>
<td>To provide two patterns for cut test</td>
<td>“Arrow” and “Cross” patterns</td>
</tr>
<tr>
<td></td>
<td>Note: It is recommended to select “Cross” if you are working on thick pieces of materials.</td>
<td></td>
</tr>
<tr>
<td><strong>Ratio Setting</strong></td>
<td>To adjust the size of the pattern</td>
<td>100%, 200%, 300%, 400%</td>
</tr>
<tr>
<td><strong>Blade Length Adjust</strong></td>
<td>Please see 2.5 Automatic Blade Length Adjustment for further details.</td>
<td>0.00mm-5.00mm</td>
</tr>
</tbody>
</table>

### [ DATA CLEAR ]

To clear up buffer memory.

### [ TOOL SELECT ]

Save Parameter: To save pattern(s) of cutting parameters for later use. There are 4 sets of parameters saved in the panel. Use Page Up and Page Down keys to select the set of parameters you wish to adjust, press “Enter” to confirm (the number shown on the upper left corner will change accordingly). Each set of parameters includes Speed, Force, Offset, Up Speed and Quality though the latter two will not be displayed in this section. To adjust or check individual parameters, go back to the responding keys on the panel and press “Enter” to

<p>| Patterns | Pattern 1 | Patterns1~4 | Pattern 1 |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Smoothing Cut</strong></td>
<td>To enable smooth-cutting function.</td>
<td>Enable</td>
</tr>
<tr>
<td></td>
<td>This function aims to make connections smoother and is suggested to be</td>
<td></td>
</tr>
<tr>
<td></td>
<td>disabled when cutting small-sized images or characters</td>
<td></td>
</tr>
<tr>
<td><strong>Over Cut</strong></td>
<td>To generate an overcut to facilitate weeding.</td>
<td>0.00mm-1.00mm, 0.05mm/per step</td>
</tr>
<tr>
<td></td>
<td>This function mainly applies to thick materials, aiming to sharpen corners</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and ensure perfect connections</td>
<td></td>
</tr>
<tr>
<td><strong>Set Tangential Mode</strong></td>
<td>To enable the emulated tangential-cutting mode for thicker media types and</td>
<td>Enable</td>
</tr>
<tr>
<td></td>
<td>small letter cuts.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: while the Offset value setting at 0.000 mm, “Set Tangential Mode”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>will automatically be disabled.</td>
<td></td>
</tr>
<tr>
<td><strong>Pouncing</strong></td>
<td>To make perforated patterns.</td>
<td>0~200mm, 0mm</td>
</tr>
<tr>
<td></td>
<td>* In order to use this function, Pouncing tool must be installed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Before start pouncing, place pouncing strip on top of the cutting pad.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Set the value as 0 mm to disable the pouncing mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Pouncing tool is an optional item.</td>
<td></td>
</tr>
<tr>
<td><strong>Panel Setup</strong></td>
<td>Accept setup command:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To accept commands of the Force, Speed, Cutting Quality, and Offset only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>via software.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control panel only:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To accept commands of the Force, Speed, Cutting Quality, and Offset only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>via control panel of the cutter.</td>
<td></td>
</tr>
<tr>
<td><strong>Restore Default</strong></td>
<td>To turn all parameters of the menu items to factory-default settings.</td>
<td></td>
</tr>
</tbody>
</table>

**[MISC]**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto Unrolled Media</strong></td>
<td>To avoid paper jam and motor crash by automatically unroll media (50cm and</td>
<td>Enable</td>
</tr>
<tr>
<td></td>
<td>up) before cutting while enabled.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Auto-unroll only affects on roll/edge media.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Using Single mode to size media will disable this function automatically.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* If the length of the rolled media is less than 2 meters or the weight is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>light, it is recommended to set this mode disabled.</td>
<td></td>
</tr>
<tr>
<td><strong>Vacuum</strong></td>
<td>To help improve tracking and cutting accuracy by turning on the fans.</td>
<td>Enable</td>
</tr>
<tr>
<td></td>
<td>If you turn off the vacuum system, the fans will remain inactive during</td>
<td></td>
</tr>
<tr>
<td></td>
<td>cutting or plotting.</td>
<td></td>
</tr>
<tr>
<td><strong>First Back to Origin</strong></td>
<td>To enable the carriage back to the previous origin; when “Enable” is</td>
<td>Enable, Disable</td>
</tr>
<tr>
<td></td>
<td>selected and the button Online/Offline has been pressed, the carriage will</td>
<td></td>
</tr>
<tr>
<td></td>
<td>go back to the previous origin while the selection of “Disable” will not</td>
<td></td>
</tr>
<tr>
<td></td>
<td>allow the carriage to do so.</td>
<td></td>
</tr>
<tr>
<td><strong>AAS Offset</strong></td>
<td>To set or modify AAS offset value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You can refer to “5.3 Printer Test” for more details.</td>
<td></td>
</tr>
<tr>
<td><strong>Paper Saving Mode</strong></td>
<td>To save media by four different modes:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Length expanded mode           2. Width expanded mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Both expanded mode            4. Both unexpanded mode</td>
<td></td>
</tr>
<tr>
<td><strong>Set Communication</strong></td>
<td>To build up the communication between host computer and cutter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Baud Rate is to determine the speed of data transmission.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Data Bits refers to the size of one block of data.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Parity is used to check if data was revived correctly or not.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9600, n, 7, 1, p               9600pbs, 7 Bits with NO Parity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9600, o, 7, 1, p               9600pbs, 7 Bits with ODD Parity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9600, e, 7, 1, p               9600pbs, 7 Bits with EVEN Parity</td>
<td></td>
</tr>
<tr>
<td>Firmware Version</td>
<td>To display the version number of Firmware and FPGA code.</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Select Language</td>
<td>To select displayed languages on LCM panel in English, Spanish, Italian, Deutsch, Japanese, Portuguese, Polish, Turkish or French.</td>
<td></td>
</tr>
<tr>
<td>Select Units</td>
<td>Provide two-unit systems for users convenient. cm/gram; inch/oz</td>
<td></td>
</tr>
<tr>
<td>Scale Length</td>
<td>To adjust the scale of media length and width that may cause by the thickness of the media.</td>
<td></td>
</tr>
<tr>
<td>Scale Width</td>
<td>1. Press the [LEFT ARROW] to choose the Numerator and select 500.0 mm, 2. Cut the length by sending a graph file, 3. Measure the length then use the [RIGHT ARROW] key to choose the Denominator, then 4. Press [UP ARROW /DOWN ARROW] to change the values of the actual length.</td>
<td></td>
</tr>
</tbody>
</table>
4. Operation

4.1 Media Loading

4.1.1 Loading the Sheet Media

To load the media properly, please follow the procedures listed below:

**Step 1**
Use the lever on the upper right side of the cutting plotter to raise or lower down pinch rollers. Pull the lever forward until it makes a clicking sound then the pinch rollers are raised (Figure 4-1).

![Figure 4-1](image1)

**Step 2**
Load your media on the platen and slide it under the pinch rollers from either the front side or the backside. The *alignment rulers* on the platen extension will help you to adjust the media precisely.

![Figure 4-2](image2)

**Note:**
Be sure that the media must cover the paper sensors on the platen when loading the media. At least one of the two paper sensors (Figure 4-2) should be covered. Once the media covers the sensor, the cutting plotter will size the media width and length automatically.
Step 3
Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must be positioned above the grid drum. The *white marks* on the top trail will remind you where the grid drums are (Figure 4-3).

Step 4
Push the lever backward to lower down the pinch rollers.

Step 5
Turn on the power, the tool carriage will measure the size of the media automatically. And the plotting cutter begins to work.

Note:
1. Always adjust the position with the pinch roller raised.
2. Move the pinch roller by applying force at the rear portion of the pinch roller support.
3. Do not move it by holding its front rubber roller (Figure 4-4).
4.1.2 Loading the Roll Media

**Step 1**

Put the roll media guide bushes on two roll holders (Figure 4-6).

---

**Note:**
Please pull up the bottom of all pinch rollers (Figure 4-5) before the lever is pushed backwards to ensure accurate media width detection.

---

**Figure 4-5**

---

**Figure 4-6**
Step 2

-- Option A (Recommended)
Insert the two roll holders into the roll media support set then place the roll media directly between the two roll holders (Figure 4-7).

Figure 4-7

-- Option B (Use the media flanges)
Insert a roll media flange at the end of each roll media and tighten the thumbscrew until the roll media is firmly gripped (see Figure 4-8).

Then put the roll media on the roll holders. Adjust the position of the roll media ensure that media flanges are able to run in the grooves of media guide bushes. (Figure 4-9)

Step 3

Load the media on the platen. Please refer to “4.1.1 Loading the sheet media”. After loading the roll media, flatten the media on the platen and hold the front edge of the roll media firmly (Figure 4-10).
Step 4
Turn the roll downward to make an equal tension across the media (Figure 4-11)

Step 5
Move the pinch rollers to the appraise location and note that the pinch rollers must be positioned above the grid drums.

Note:
Make sure that the media tension is equally distributed from left to right. If the media were not tightened enough against the platen, it would cause tracking problems!

Step 6
Push the lever backward to lower down the pinch rollers.

Step 7
Fix roll media guide bushes on the roll holder to secure the roll media.

Step 8
Turn on the power switch, the tool carriage will sizing the media automatically. Then the cutting plotter is ready to work.

Step 9
Use the reverse steps to remove the media.
4.2 Tracking Performance

In order to achieve the best tracking performance for a long plot, we recommend some significant media loading procedures described as follows:

If the media length is less than 4 meters, leave the margin of 0.5mm—25mm in the left and right edges of the media (Figure 4-12).

![Figure 4-12](image)

If the media length is greater than 4 meters, leave at least 25mm margin on the left and right edges of the media (Figure 4-13).

![Figure 4-13](image)

Please refer to the paragraph “4.5 How to Make A Long Plot” for more details.
4.3 Cutting Force and Offset Adjustment

Before sending your designs for cutting, you may perform a “cut test” to generate satisfactory cutting results. The “Cut Test” should be repeated until the appropriate cutting conditions for the media are discovered.

After sizing the media, press [CUT TEST] button to select the “square cut”, and press [ENTER KEY] to confirm.

The default cutting force and offset value of the cutting test are 80gf and 0.275mm respectively. Press [ARROW KEY] to move the tool carriage to the position where you like. Then, press the [ENTER KEY] to perform Cut Test.

Note: At the same time, the new origin is also set at the cutting test position.

When the cutting test is completed, a pattern appears. Peel off the pattern to see if it can be easily separated from the media base. If yes, the setup tool force is appropriate. If not or cut through the back paper, press [FORCE KEY] to adjust the tool force until an optimum force is obtained (Figure 4-14).

If the pattern appears to be BB or CC layout, press [OFFSET KEY] to adjust the offset value until AA pattern discovered. Increase the offset value when BB occurs and decrease the value when CC appears.

![Figure 4-14](image)
4.4 How to Cut 3mm Letters

To obtain good quality output, narrow media is recommended. However, if wide media is used, you should:

1. Position two pinch rollers as close as possible to both edges of the cutting area.
2. Make sure the loaded media is held flat with equal tension across the platen.
3. Suggested operation settings:
   - Force: 55 gf. (or depending on the material)
   - Speed: 45-50 cm/sec
   - Up speed: 45-60 cm/sec
   - Set smoothing cut: Disable
   - Cutting quality: Small Letter

4.5 How to Make A Long Plot

When you are making a long plot with a roll of heavy and wide vinyl, paper you need to use the “AUTO UNROLL MEDIA” function. The following parameter settings are to help users get the best cutting quality. The actual output quality may vary when using different kind of materials

1. If the length of graphic is between 3m and 5m, the cutting speed is better slower than 72cm/sec and the cutting quality is set as Normal.
2. If the length is longer than 5m or if the material type is difficult to cut, it is better to further slow down the cutting speed.
3. After loading the roll media all pinch rollers are raised at this stage, flatten the media on the platen and hold the front edge of the roll media firmly (Figure 4-15).

![Figure 4-15](image-url)
Then turn the roll downward to make an equal tension across the media
(See Figure 4-16)

Make sure that the media tension is equally distributed from left to right. If the media is not tight enough against the platen, it will cause tracking problems.

4. Engage pinch rollers.
5. Fixes roll media guide bushes on the roll holder to secure the roll media.
6. The protrusion length of the blade should be longer than the thickness of the vinyl.
   (Please check the “Blade Specification: About the Tool” in Appendix.) After you notice all the above, you’ll enjoy your gigantic signs production!

4.6 When Completing the Cutting Job

After completing the cutting job, raise the sheet-loading lever, and then remove the material. You can also cut off the finished job by the Safe Blade (a standard accessory) along the knife guide. (Figure 4-17)
4.7 ValueCut series Print Driver setting

4.7.1 ValueCut series Print Driver setting > Option Page

**Figure 4-18**

**Setting:** You can adjust the following settings, depending on your application or results you would like to achieve.

**Quality:**
[Slower speeds / higher quality - Faster speeds / lower quality]
The Cutting Quality setting function allows you to adjust and balance vector mode’s quality and speed settings based on your specific job. Draft Mode offers the highest output speed, sacrificing quality. Whereas Small letter Mode offers the highest quality, sacrificing output speed. Keep in mind that speed and quality are usually at a tradeoff.

**Blade:**
Choose the blade type used for this job.
Use Plotter Setting:
The parameter settings will be set according to those set from the control panel.

Back to home:
The carriage will return to the original position when this option is selected.

Vector Function
Normal:
This is the default Vector Function setting. The cutting order depends on the order of the graphics created in the application software.

X sorting:
The cutting order is based on the next closest object on the x-axis from the origin. The cutting order of the sample below will be 1,2,3,4 (please refer to figure 4-20).

![Figure 4-19](image)

Inside Out Cutting:
When performing a vector cutting job in which your image has one vector cut area enclosed within another vector cut area, select the Inside-out Sorting mode. This mode will automatically instruct the print driver to process the inside vector image and moving outwards. This setting will always automatically direct the cutter to cut from the inner most vector shape and move outwards.
Cutting Path Optimization:
This is a setting that will minimize your process time. When selected, the print driver will analyze your image and automatically determine the most efficient processing path to process your image.

File Function (Option Page):
The file function section allows you to manage various cutter parameters. This section is useful when performing repeated jobs on a variety of objects, allowing you to save your frequently used cutter parameters and load them in the future.

- History File: This section contains a list of the recent files you have recently created and worked.

- SAVE: This function will save current print driver parameter settings to a file under the specified location on your computer. (Saved parameter setting files will be tagged with the ValueCut series extension)

- LOAD: This function allows you to load previously saved print driver parameters.

- ORIGINAL: This function will load the print driver's original factory parameter settings.

- SAVE TO DEFAULT: This function allows you to save your current print driver parameters as the default startup settings.

- DELETE: This function will delete the file you select from the History File section. Please note the delete function only removes the file from the history file section, it does not remove the ValueCut file from your hard drive, if you wish to completely remove the file from your hard disk, and you will have to manually delete the file from your operating system.

Note:
If you are using Windows 2000 or XP as your operating system, then make sure you log in with an administrator or administrator-rights account in order to properly save cutter parameter settings.
4.7.2 ValueCut series Print Driver setting > Pen Page

The ValueCut series incorporates the use of 16 different colors to represent 16 different parameter settings including cutting speed, force and blade offset settings when cutting. These colors are referred to as “Pens”. Think of each pen as a designated cutter setting, rather than as a color. An image that is made up of black, red and blue colors will be processed using the cutter settings designated for each particular color. In order to utilize up to 16 different pens (cutter parameter settings), make sure your graphics software can recognize and utilizes the 16 pen colors designated by the ValueCut series print driver (please refer to figure 4-21).

![Figure 4-20](image_url)

If you would like to specify your own colors to designate to a particular cutter setting, then all you have to do is to double-click on that particular pen color from the pen menu and a color manager window will open where you can select “define custom colors” to define your own color (shown in the picture below). This is useful when your image is composed of colors that are not part of the pen menu’s default color selection, and instead of modifying your image, you simply would like to assign the cutter settings based on the existing colors from your current image.
The speed slider controls the cutter’s cutting speed during operation with a range setting from 3 – 153cm/sec. The ValueCut series maximum cutting speed is 153 cm (60 inches) per second.

The force slider controls the cutting force during operation with a range setting from 5 – 600g.

The offset slider controls the blade offset depending on the blade you used.

The Die Cut function can allow you to cut through the backing of the material. You can only use the first 8 pen for this function. If you choose Pen No.1 and click the Die Cut function, the Pen No.9 will become Pen No.1* for setting different parameter for the same cutting line. (Figure 4-24)

Note:
The ValueCut series print driver cannot store more than 16 pen colors or different cutter parameter settings per file.
You can adjust the parameter such as force and length in both Pen No.1 and Pen No. 1* as you need.

For example:

Pen No.1: Cutting through the vinyl only

Pen No.1*: Cutting through the backing of the material
Figure 4-25
4.7.3 ValueCut Print Driver setting > Paper Page

**Paper Size (Paper Page) [DEFAULT SETTING: Y = the width of machine; X will be automatically set to be twice the length of Y]**

The paper size represents your total work area. The X value represents the length and the Y value represents the width. The paper size should be set as the same as your image so you can get a better cutting quality.

**Unit (Paper Page) [DEFAULT SETTING: Metric (mm)]**

Here you can set your preferred measurement standard in which you would like use with the VALUECUT series print driver. You can choose between metric or imperial standards.
Chapter 5 Automatic Aligning System

5.1 Introduction

The ValueCut series cutting plotters feature a standard Automatic Aligning System (AAS II) to guarantee precise contour cutting quality by detecting the registration marks printed around the graphic.

**Notice**
- Avoid any kind of light source horizontally illuminating the AAS module.

- PROHIBITED
- ACCEPTABLE

- DO NOT take off the cover of AAS module while in operation.

- PROHIBITED
5.2 AAS Calibrating the System

The AAS system has one calibration procedures to ensure maximum accuracy of AAS operation. To operate the AAS you need to learn about the method of media feeding firstly. (Refer to 4.1 Media Loading.)

5.2.1 Media Calibration

Media Calibration is to ensure the sensor being able to recognize the registration marks. The factory default works on a wide range of materials. However, certain types of materials may not work properly. Performing a media calibration may become necessary while working with such materials to change the sensitivity of AAS for greater reliability. Media calibration adjusts the media feeding according to media type for better accuracy during cutting.

- When to use

We suggest white media for best cutting result. It is not necessary to perform media calibration every time unless the registration marks on the printed media become undetectable in AAS sensing process.

5.2.2 AAS Calibration

The first registration mark is designed to be different in order to identify the origin for AAS auto-detection. The following precaution must be aware for registration marks to be read automatically.

- Type of media
- Registration mark pattern
- Reading range required for detection the registration marks
- Position for registration marks and medium

The registration marks have to be:

- Created by cutting software like CorelDRAW plug-in
- In black color (printing quality of registration marks is essential; incorrect, misaligned colors, blurry or smeared printout might leading to inaccurate cutting result)
- Length: The length of marks
  → Range: 5mm~50mm
  → Optimized Setting: 25mm
- Thickness: The line thickness of marks
  → Range: 1mm~2mm
    → Optimized Setting: 1mm
- Margin: The distance between marks and images
ValueCut User Manual

→ Range: 0mm~50mm
→ Optimized Setting: 5mm

The cutter can not detect the marks while:

- Cutter carriage is not located near the outside area of first mark before detecting
  (See the picture in page 5-7 for auto-detecting area of first mark.)
- Medium thickness is more than 0.8mm
- Transparent medium is used
- Non-monochrome drawing. The marks can’t be read if is printed on colored medium
- Dirty or creased medium surface

5.2.3 AAS II on ValueCut
There are three types of AAS II mark patterns: 4-Point Positioning, Segmental Positioning, and Multiple Copies. Note that before print out your designs by inkjet printers, the registration marks have to be created on your graphic designs by cutting software like CorelDraw plug-in. Hand-made marks or drawings won’t be reorganized by Mutoh cutting plotters. For more details about registration mark setting in cutting software, please refer to ‘Appendix A-4: CorelDraw Plug-In Instruction’.

1. 4-Point Positioning
   This is the basic mark pattern that AAS II will auto detect four registration marks and contour cut images inside those marks.
   - Command: Esc.D1;(XDist);(YDist):
   - Layout: 4 L-shaped marks at the 4 corners around the design

   ![4-Point Positioning Diagram]

2. Segmental Positioning
   In addition to 4 original points, the intermediate registration marks are added on both X axis and Y axis to help contour cut accurately, especially for cutting large images.
   - Command: Esc.D2;(XDist);(YDist);(XStep);(YStep):
   - Layout:
     In-between distance on X: 200~600mm, default 300mm
     In-between distance on Y: 200-600mm, default 300mm
High Precision Long Picture Cutting

ValueCut performs segmental cutting to enhance output qualities.

- The object will be output following the Data Block pattern based on the Segmental Positioning parameters.
- Cutting sequence: Date Block1 -> Date Block2 -> Date Block3 -> Date Block4

3. Multiple Copies

The function is used to duplicate images to let you cut quantities of images at a time. The AAS II sensor will automatically scan registration marks for each individual image to ensure the contour cutting precision.

- Command: Esc.D3;(XCopies);(YCopies);(Space):
- Layout:

<table>
<thead>
<tr>
<th>Condition 1 (Default)</th>
<th>Condition 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Condition 1 Diagram" /></td>
<td><img src="image2" alt="Condition 2 Diagram" /></td>
</tr>
</tbody>
</table>
5.2.4 Automatic Distinction of the Plot Direction

For the convenience of users, ValueCut automatically detects the feeding direction of the material when performing contour cutting. Figure 5-1 shows the Registration Mark detection sequence when the material is fed in the standard way (1->2->3->4) while Figure 5-2 is how ValueCut detects registration marks (3->4->1->2) when the material is reversely fed. ValueCut is able to detect registration marks and performs contour cutting however users feed the media.

Direction detection steps:
- a. Detects the position of the 3rd Registration Mark
- b. Proceeds to the 4th Registration Mark to detect the direction
  (The existing detection procedure will be performed, followed by the detection of new line segments)
- c. The information is reflected in the driver and recalculated before output
- d. The registration mark detection and object output process is implemented
  (Registration Mark detection sequence: 3->4->1->2)

![Figure 5-1](Standard Media Feeding Direction)

![Figure 5-2](Reversed Media Feeding Direction)

5.3 Printer Test

Before performing AAS contour cutting, it’s recommended to print out a test file that you can find in the enclosed Installation CD to make sure the AAS II cutting accuracy of ValueCut.

There are two testing files for AASII:
1. AAS_II_X_Y_Offset_Caberation_A4.eps (A4 size)
2. AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended for testing)

Print out the testing graphic. (Please use high precision printer)
Load the graphic to ValueCut and sent the file to test the cutting job

- If there are any adjustments to be made, you can change the offset value by following the steps:
  - Measure the offset values from the printed line and the actual cutting line.
  - Enter the AAS Offset under MISC function for the values you just measured, then press Enter
  - Test the cutting again
  - AAS II offset X and Y value is defined as following:

    Horizontal line is defined as X and vertical is defined as Y (when facing the cutting plotter)

    When the actual cutting line and the printed line need to be changed towards the direction of origin mark, then simply add the negative value of the offset. If the direction is from the opposite of the origin mark, then enter positive values for the offset (see the following figures). This method applies to both X and Y axes.
5.4 Registration Mark Offset Range
Please correctly load your media (refer to the alignment ruler on the platen) to make sure the registration marks are successfully detected. Deviation exceeds the range below will lead to detection failure.

\[
\begin{align*}
\text{Registration Mark Length range: } & \quad 5 \sim 50 \text{ mm} \\
L (\text{Registration Mark Length}) & \\
S (\text{Deviation of Registration Mark}) & \\
\text{Deviation range: } & \quad \frac{L}{2} \leq S \leq \frac{L}{2} \\
\text{Registration Mark Length range: } & \quad 5 \text{ mm} \leq L \leq 50 \text{ mm}
\end{align*}
\]

5.5 Contour Cutting
For accurate contour cutting with AAS function, please proceed the following steps:

**Step 1** Creating Graphics
- Create the graphic that you want to print and cut in your software.
- Create a contour for cutting around the graphic.
TIPS1: Leave some space between the graphic and contour line.  
TIPS2: Create the contour in a separate layer and assign a different color for it.

- Add registration marks around the graphic.

---

**Note:**
The Multiple Copies function is also available. It automatically copy the graphic and registration marks.

---

### Step 2 - Placing the Registration Marks

- The AAS Layout Instruction:

* Auto-detection function on the 1st mark covers the grey area
  - Suggested 30mm margin on both left and right sides of media sheet.
  - Suggested 50-70 mm margin on top and bottom edge of the media sheet to prevent sheets dropping or any error occurred while media sizing.
**Step 3** Print the Graphics

- Print the graphic and the marks with your printer

(Scaling = 100%).

- When printing on a roll media, make sure the orientation as following:

**Step 4** Load the printout onto cutter

- The Origin Mark is is different from the rest registration marks. Please make sure the media is fed with correct direction.

**Step 5** Cut the Contour

- Send out the command from software to perform the contour cutting job.

### 5.6 Tips for AAS

For getting better results of contour cutting, there are some tips below for your reference.

- Keep light sources simple and avoid illuminating from the sides of cutter.
- Before operating AAS, change the maximum paper size in ValueCut driver property.

**STEP 1** Find the ValueCut model in the “Printer & Fax” folder of your PC.
**STEP 2** Open the Properties window and select the “Paper” tab.

**STEP 3** Change the maximum Paper Size of X to **1200** mm.

- Adjust the cutting speed to between 300~600mm/sec.
- Avoid the registration marks locating on the tracks of pinch rollers.
6. Maintenance

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required for the cutting plotter. Except for the procedures mentioned below, all other maintenance must be performed by a qualified service technician.

6.1 Cleaning the Cutting Plotter

Cleaning the machine properly and regularly will ensure optimal performance out of your machine.

Cleaning Precaution!

- Unplug the cutting plotter before cleaning it in order to prevent electrical shock.
- Never use solvents, abrasive cleaners or strong detergents for cleaning. They may damage the surface of the cutting plotter and the moving parts.

Recommended Methods:

- Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, with a damp cloth immersed in water or alcohol. Dry and wipe any remaining residue off a soft, lint-free cloth.

- Wipe all dust and dirt from the tool carriage rails.

- Use a vacuum cleaner to empty any accumulated dirt and media residue beneath the pinch roller housing.

- Clean the platen, paper sensors and pinch rollers with a damp cloth immersed in water or alcohol, and dry with a soft, lint-free cloth.

- Wipe dust and dirt from the stand.
6.2 Cleaning the Grid Drum

1. Turn off the cutting plotter, and move the tool carriage away from the area needed to be cleaned.

2. Raise the pinch rollers and move them away from the grid drum for cleaning.

3. Use a bristle brush (a toothbrush is acceptable) to remove dust from the drum surface. Rotate the drum manually while cleaning. Refer to Figure 6-1.

![Figure 6-1](image)

6.3 Cleaning the Pinch Rollers

1. If the pinch rollers require a thorough cleaning, use a lint-free cloth or cotton swab to wipe away the accumulated dust from the rubber portion of the pinch rollers. To prevent the pinch rollers from rotating while cleaning, use your finger to hold the pinch rollers to prevent them from rotation.

Note:
The daily maintenance of your cutting plotter is very important. Be sure to clean up the grid drum and pinch rollers regularly for better cutting accuracy and output quality.
7. Trouble Shooting

This chapter is to help you correct some common problems you may come across. Prior to getting into the details of this chapter, please be sure that your application environment is compatible with the cutting plotter.

Note:
Before having your cutting plotter serviced, please make sure that the malfunction is in your cutting plotter, not the result of an interface problem or a malfunction in your computer or a software problem.

Why is the cutting plotter not functioning?

Possible Causes:

7.1 Non-Operational Problems

Check the following first:
- Does the AC power cord plug in properly?
- Does the AC power cord connected to the power connector properly?
- Does the power LED still illuminate?

Solutions:

If the LCM is able to display the message, the cutting plotter should be in a normal condition. Switch off the cutting plotter and turn it on again to see if the problem still existing.

If the LCM is not able to display any message, contact the technician from your dealer.
7.2 Operational Problems
Some mechanical problems or failure during operation will cause some problems. If the problem still exists after the recommended actions have been taken, have your cutting plotter serviced.

7.2.1 LCM Error Messages
The error messages shown on the LCM present the problem first, and followed by recommended actions.

**Error, Check Media Or Drum or X Motor**
This message indicates that there might be a problem on the X axis (the media feeding direction). Check if the drum is working well and if the media is well loaded. Correct the problem and re-power on to reboot system.

**Error, Check Media Or Y Motor**
This message indicates that there might be an obstruction to carriage relating to a problem on the Y axis (the carriage moving direction). Correct the problem and re-power on to reboot system.

**Error, Check Carriage Sensor or VC Motor**
This message indicates that the blade up/down sensor malfunction. Re-power on to re-boot system. If the problem still exists, find a serviceman.

**Graph Was Clipped. Data In Buffer**
This message indicates that the cutting exceeds the cutting limit. Reload larger media or re-scale the plot to a smaller size; then press the key followed by the display of LCM to continue.
7.2.2 Other operational problems
1. Pinch rollers

**Note:** Never press the top release grip (the release grip is fully pressed when a clip sound is heard) and pull the bottom release grip at the same time as the pictures shown below. This will prevent you from disabling the pinch roller as the stop bar will not reach the correct position and therefore will not be functioning.

**O (CORRECT)   × (INCORRECT)**

- Press
- **DISABLE**
- Pull up bottom to release grip
- **ENABLE**

- Press down
- **Stop bar**
2. Media is rolled up during the cutting process
Step 1 Turn off the cutting plotter
Step 2 Move the pinch rollers to the side
Step 3 Pull the lever up
Step 4 Trim off the rolled up part of the media
Step 5 Reload the material

3. The media runs diagonally
Step 1 Stop the operation
Step 2 Move the pinch rollers to the side
Step 3 Pull the lever up
Step 4 Reload the media and make sure the media is correctly loaded (refer to the alignment ruler).

4. The media lifts
Step 1 Stop the operation
Step 2 Move the pinch rollers to the side
Step 3 Pull the lever up
Step 4 Reload the sheet and ensure there are two pinch rollers on the very two sides of the sheet.
Step 5 Ensure the vacuum is on (check the control panel) and increase the number of pinch rollers.

5. The start and end points of the object are shifted
Step 1 Move the pinch rollers to the side
Step 2 Pull the lever up
Step 3 Reload the media and increase the number of pinch rollers.
Step 4 Activate “Over Cut” in “Tool Select” on the control panel if the above does not work
7.3 Cutting Plotter/Computer Communication Problems

The messages showed below present problems in relation to cutting plotter/computer communication.

Communication Error
Setup: MISC. key

Is the connection cable connected to the cutting plotter and computer properly?

Yes

Has the interface setting been done correctly?

Yes

Try the communication between your cutting plotter and computer. If it still does not work, have your cutting plotter serviced.

No

Refer to the “MISC” key in Chapter 3 - Description of Operation for the port setup.

No

Refer to Chapter 2 - Connecting your cutting plotter.

Note:
The computer also needs to set up compatible communication parameters to the cutting plotter set up.

HP-GL/2 Cmd. Error

If your cutting plotter can not recognize the HP-GL/2 or HP-GL commands, please check the HP-GL/2 or HP-GL commands applied to your cutting plotter are used properly.
7.4 Software Problems

Check the following first:

Does your software package indicate that it will work with your computer and cutting plotter?
Does your software support HP-GL and HP-GL/2 drivers? (* check the configuration settings of your software.)

Yes No

Does the cutting plotter interface match the requirements of your software?

Yes No

Most well known cutting softwares in the world have drivers for our cutting plotters. If not, use software that has HP-GL and HP-GL/2 emulation supports and you can chose the following three drivers:
- A3 size: HP7475A
- A1 size: HP7580A
- A0 size: HP Draf Pro Exl or HP Draf Master

Try using the recommended cable.

Refer to Chapter 2 - Connecting your cutting plotter.

Does the software vendor provide a sample file?

Yes No

Re-power on the cutting plotter and try to send the file again.

Do something about the error message display on LCM, or consult your software vendor.
### 7.5 Cutting Quality Problems

**Note:** The daily maintenance of your cutting plotter is very important. Be sure to clean up the grid drum and pinch rollers regularly for better cutting accuracy and output quality.

Diagram:

1. **Is the blade installed correctly and the blade holder fastened securely?**
   - **Yes**
     - **Is the blade dull or chipped?**
       - **Yes** Replace with a new blade
       - **No** **Is tool force set up properly?** (The default for tool force is 80 gf)
         - **Yes** Adjust the tool offset to obtain an optimum value.
         - **No** Adjust the tool force to obtain an optimum blade force. Refer to Chapter 4.3 “Cutting Force and Offset Adjustment”
   - **No** Refer to Chapter 2.4 “Blade Installation”

2. **Is there any dirt adhered to the blade?**
   - **Yes** Remove the blade and clean it.
   - **No** Please contact your dealer for technician support.
## ValueCut Specification

<table>
<thead>
<tr>
<th>Model Number</th>
<th>VC-600</th>
<th>VC-1300</th>
<th>VC-1800</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Method</td>
<td>Roller-Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. Cutting Width</td>
<td>610mm (24in)</td>
<td>1320mm (52in)</td>
<td>1830mm (72in)</td>
</tr>
<tr>
<td>Max. Cutting Length</td>
<td>50m (164ft)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. Media Loading Width</td>
<td>770mm (30.3in)</td>
<td>1594mm (62.7in)</td>
<td>1900mm (74.8in)</td>
</tr>
<tr>
<td>Min. Media Loading Width</td>
<td>50mm (1.97in)</td>
<td>300mm (11.8in)</td>
<td></td>
</tr>
<tr>
<td>Number of Pinch Rollers</td>
<td>3</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>Acceptable Material Thickness</td>
<td>0.8mm (0.03in)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drive Motor</td>
<td>DC Servo Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cutting Force</td>
<td>5~600 g</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. Cutting Speed</td>
<td>1530 mm/sec (60ips / Diagonal)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acceleration</td>
<td>4.2 G (gravity)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offset</td>
<td>0~1.0 mm (with an increase of 0.025mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory Buffer</td>
<td>4 MB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interfaces</td>
<td>USB 2.0 (Full Speed) and Serial (RS-232C)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type of Command</td>
<td>HP-GL, HP-GL/2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mechanical Resolution</td>
<td>0.006mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software Resolution</td>
<td>0.025 mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Distance Accuracy</td>
<td>±0.254 mm or ±0.1% of move, whichever is greater</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Repeatability</td>
<td>±0.1mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Curve &amp; Arc Smoothing</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configurable Origin</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Cut capability</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tangential</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Repeat</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pouncing</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Panel</td>
<td>LCD (20 digits x 2 lines), 14 Keys, 1 Power LED</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Supply</td>
<td>AC 100-240V, 50/60 Hz (auto switching)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Consumption</td>
<td>251.8 watts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimension (HxWxD) mm</td>
<td>414 * 930 * 490</td>
<td>1166 * 1754 * 667</td>
<td>750 * 2170 * 1160</td>
</tr>
<tr>
<td>(HxWxD) in</td>
<td>16.3 * 36.6 * 19.2</td>
<td>45.9 * 69.1 * 26.3</td>
<td>29.5 * 85.4 * 45.7</td>
</tr>
<tr>
<td>Net Weight</td>
<td>18 kg</td>
<td>50 kg</td>
<td>64 kg</td>
</tr>
<tr>
<td>Stand</td>
<td>Optional</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Automatic Aligning System</td>
<td>Completely Automatic Contour Cutting System for print to cut solution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Basket</td>
<td>Optional</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Operation Temperature</td>
<td>15℃<del>30℃ / 60°F</del>86°F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Environment Humidity</td>
<td>25% ~ 75%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Compatible with Windows 2000/XP/7/Vista.
- The specification and data sheet may vary with different materials used. In order to obtain the best output quality, please maintain the machine regularly and properly.
- Mutoh reserves the right to change the specifications at any time without notice.
- The above listed specification values are effective only when operated with media certified by Mutoh.
For cutting thick fluorescent and reflective vinyl. Also for cutting detailed work in standard vinyl.

The blade is 45° with **Red Cap** (5-unit package), 0.25 mm offset

For cutting reflective vinyl, cardboard, sandblast, flock, and stencil sharp edge.

The blade is 60° with **Green Cap**, 0.50 mm blade offset

For cutting thin sandblast mask and stencil with friction feed or sprocket feed machine.

The blade is 60° with **Blue Cap**, 0.25 mm blade offset

For cutting small text and fine detail. Sharp blade with smallest offset.

The blade is 0.175 mm blade offset with **Black Cap**

For thin and delicate media such as window tint

The blade is 25° with **Yellow Cap**, 0.25 mm blade offset
About the Tool

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the LED bombsight (option) used for pointing to the reference point. OFFSET is the distance that the blade tip is displaced from the centerline of the blade.

![Diagram of blade with annotations]

Protrusion Length of the Blade

Length of protrusion = $t_1 + \frac{t_2}{2}$, but for your convenience you may just make it about $0.3\text{mm} \sim 0.5\text{mm}$ beyond the blade holder tip.
## Consumable and Optional Item List

### Consumable Items

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC-CHD</td>
<td>Cutting Blade Holder</td>
</tr>
<tr>
<td>VC-CBRE5</td>
<td>Cutting Blade Red Cap (45° 0.25) (5pcs/box)</td>
</tr>
<tr>
<td>VC-CBGR1</td>
<td>Cutting Blade Green Cap (60° 0.5) (1pcs/box)</td>
</tr>
<tr>
<td>VC-CBBU1</td>
<td>Cutting Blade Blue Cap (60° 0.25)(1pcs/box)</td>
</tr>
<tr>
<td>VC-CBBK1</td>
<td>Cutting Blade Black Cap (42° 0.175)(1pcs/box)</td>
</tr>
<tr>
<td>VC-CBYE5</td>
<td>Cutting Blade Yellow Cap (25° 0.25)(5pcs/box)</td>
</tr>
<tr>
<td>PSGB-BK</td>
<td>Pressurized Ballpoint Pen</td>
</tr>
<tr>
<td>VC-CMAT</td>
<td>Cutting Pad (W6mm*L10m)</td>
</tr>
<tr>
<td>VC-PT</td>
<td>Pouncing Tool assembly (Diameter: 1.5mm)</td>
</tr>
<tr>
<td>VC-PMAT</td>
<td>Pouncing Pad(L=1.5m)</td>
</tr>
<tr>
<td>VC-TW</td>
<td>Tweezers(L=11cm W=0.85cm)</td>
</tr>
<tr>
<td>VC-SB</td>
<td>Safe Blade</td>
</tr>
</tbody>
</table>

### Optional Items

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC-STD600</td>
<td>Stand for VC-600 (with Basket)</td>
</tr>
<tr>
<td>VC-TBL</td>
<td>Add-on flat table for VC-600</td>
</tr>
<tr>
<td>VC-RS</td>
<td>RS-232 Cable (25 pin)</td>
</tr>
<tr>
<td>VC-USB</td>
<td>USB Cable</td>
</tr>
</tbody>
</table>
CorelDRAW Plug-In Instruction

AASII VBA Installer is applicable for CorelDRAW Version 11, 12, 13, 14, 15, 16.

Installation

1. Check the “AAS CorelDraw Installer” folder in ValueCut Installation CD, and double click the “AASIIInstaller.exe” file to run the installation program.

2. Press the “Install” button to begin installing AASII CorelDRAW VBA.
User Instructions

1. Run CorelDRAW to edit your graphics and select all images at once when you wish to plot.

2. Select “Tools → Visual Basic → Play”.
The **Visual Basic for Applications Marcos** window will pop up. Select **Global Macros(AASII_Draw.gms)** under the “Macros in” manual, and press “Run”.

3. Click on “Apply” and select whether you would like to add the registration marks by page size or by object.

4. Now you can print out the image file with registration marks.

**Note:**

Note: “Add Registration Mark by Object” will be the default selection if you click on the image whereas “Add Registration Mark by page size” will be the default one when the blank area on the page is clicked.
Add Registration Mark by page size

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”, your registration marks will be created automatically.

Note:
The length setting will be in the range of 5-25mm according to your page size. Please DO NOT make any changes to the “Origin” section when you choose to add registration marks by page size as indicated below otherwise the position of the marks will be changed.

The system will create the 4 marks on the 4 corners of the page as shown in the picture below wherever you move your image.
Add Registration Mark by Object

If you tick “Add Registration Mark by Object”, you will be offered three options of registration marks as shown below.

4-Point Positioning
- Length: The length of marks
  - Range: 5mm~50mm
  - Optimized Setting: 25mm
- Thickness: The line thickness of marks
  - Range: 1mm~2mm
  - Optimized Setting: 1mm
- Margin: The distance between marks and images
  - Range: 0mm~50mm
  - Optimized Setting: 5mm

Segmental Positioning
- X Step: The distance of intermediate position on the X axis
  - Range: 200mm~600mm
  - Optimized Setting: Less than 500mm
- Y Step: The distance of intermediate position on the Y axis
  - Range: 1~50

Multiple Copies
- No. of X Copies: The numbers of copies on X axis
- No. of Y Copies: The numbers of copies on Y axis
  - Range: 1~50. (The more copies you make, the more time is needed for data transmission.)
  - Numbers of X Copies * Numbers of Y Copies = The total amount of image copies
- Copies with outline: To show outlines of image graphics

Note:
The values entered in the “4-Point Positioning” section (length, thickness and margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies.”
4-Point Positioning

- **Length**: The length of marks
  - Range: 5mm~50mm
  - Optimized Setting: 25mm
- **Thickness**: The line thickness of marks
  - Range: 1mm~2mm
  - Optimized Setting: 1mm
- **Margin**: The distance between marks and images
  - Range: 0mm~50mm
  - Optimized Setting: 5mm

The system will create the 4 marks as shown in the picture below.
Note:
The values entered in the “4-Point Positioning” section (length, thickness and margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”.

1. To save your materials, in addition to amending object margins, you can also adjust the length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see table 1 for suggestions based on different material sizes). The smaller the size is, the smaller the distance between the object and the registration marks is (see the figures below).

![Area to be cut](image)

<table>
<thead>
<tr>
<th>Page size</th>
<th>Suggested mark length</th>
</tr>
</thead>
<tbody>
<tr>
<td>(unit: inch)</td>
<td>(unit: mm)</td>
</tr>
<tr>
<td>A6 (4.13 × 5.83)</td>
<td>5</td>
</tr>
<tr>
<td>A5 (5.83 × 8.27)</td>
<td>8</td>
</tr>
<tr>
<td>A4 (8.27 × 11.69)</td>
<td>11</td>
</tr>
<tr>
<td>A3 (11.69 × 16.54)</td>
<td>16</td>
</tr>
<tr>
<td>A2 (16.54 × 23.39)</td>
<td>23</td>
</tr>
<tr>
<td>A1 (23.39 × 33.11) and above</td>
<td>25*</td>
</tr>
</tbody>
</table>

Table 1

*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the previous setting will be applied.
For precise cutting quality, it is suggested to select “Segmental Positioning” when you are working on an extra long or large-sized image to increase cutting accuracy.

**Segmental Positioning**

- **X Step**: The distance of intermediate position on the X axis
- **Y Step**: The distance of intermediate position on the Y axis

  - Range: 200mm~600mm
  - Optimized Setting: Less than 500mm

The system will create the marks as shown in the picture below.
Multiple Copies

It is suggested to select “Multiple Copies” when you would like to make several copies of one image on your material to increase cutting accuracy.

- **No. of X Copies**: The numbers of copies on X axis
- **No. of Y Copies**: The numbers of copies on Y axis
  - Range: 1~50. (The more copies you make, the more time is needed for data transmission.)
  - Numbers of X Copies * Numbers of Y Copies = The total amount of image copies
- **Copies with outline**: To show outlines of image graphics

The system will create the as shown in the picture below.
Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large size (with the length or width over 200mm) to increase the accuracy of registration mark detection.

Please make sure you are happy with the settings for Segmental Positioning as these will be applied to the copies created.
Contour cutting through CorelDraw

Step 1: Position the paper with registration marks printed by your printer on the cutter.

Step 2: Select “Files→Print”.

Please note that if you use CorelDraw X5, you must follow the steps below.
Click the “color” page and go to the “Color conversions performed by:” and then select the model name of your cutter.
Step 2: Go to the “Layout” page and select Bottom left corner at “Reposition images to”.

Step 3: Click “Print”.

You can also add a Hot Icon for the AAS II Plug-in

Step 1: Select “Tools→Customization→Commands→Macros”.
Step 2: Choose [__CorelDraw_AASII.Module.__AASII] and drag it to the “commands” bar.

Step 3: If you want to have a different icon, select “Tools→Customization→Commands→Appearance” to import a graphics for use as the icon. Choose an icon and press OK to complete this setting.
AASII VBA Installer is applicable for Illustrator Version CS3, CS4, CS5, CS6.

Installation

1. Check the “AAS Illustrator Installer” folder in ValueCut Installation CD, and double click the “AASIIInstaller.exe” file to run the installation program.

2. Press the “Install” button to begin installing AASII Illustrator VBA.
User Instructions

1) Open Illustrator.

2) Edit your image and create a contour line

Note: You must have the line width set as 0.001mm

3) Click on the image and apply the AAS function (File→Scripts→_AASII_Plug_In)
4) Select the registration marks needed

5) Three types of registration marks are introduced here: 4-Point Positioning, Segmental Positioning and Multiple Copies.
6) Confirm the registration marks (the 4-Point Position mark is used as an illustration in the following steps).

**Note:**
The values entered in the “4-Point Positioning” section (length, thickness and margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”.

![Illustrator Plug-In User Manual](image.png)
7) Click on the blank area on the page and then click “Document Setup”.

8) Hit “Edit Artboards”

Note:
Keep all Bleed settings as zero when performing segmental cutting to ensure accurate output.
9) Click on “Presets → Fit Artboard to Artwork bounds”.

10) Please move your mouse to the tool bar on the left when step 10) is finished and then click “Selection Tool”.

![Illustrator Plug-In](image)
11) This will take you back to the edit mode.

12) Print out the file with the contour line and the registration marks.

13) Place the printed file on the cutter, lower the pinch rollers and then position the carriage at the origin of the registration marks.

14) Send the file to the cutter.
15) Select the cutter model, position the object in the bottom left corner and then click “Print”.

16) Your job is now completed.
Three types of registration marks

4-Point Positioning

- **Length**: The length of marks
  - Range: 5mm~50mm
  - Optimized Setting: 25mm
- **Thickness**: The line thickness of marks
  - Range: 1mm~2mm
  - Optimized Setting: 1mm
- **Margin**: The distance between marks and images
  - Range: 0mm~50mm
  - Optimized Setting: 5mm

The system will create the 4 marks as shown in the picture below.
Note:
The values entered in the “4-Point Positioning” section (length, thickness and margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”.

1. To save your materials, in addition to amending object margins, you can also adjust the length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see table 1 for suggestions based on different material sizes). The smaller the size is, the smaller the distance between the object and the registration marks is (see the figures below).

<table>
<thead>
<tr>
<th>Page size</th>
<th>Suggested mark length</th>
</tr>
</thead>
<tbody>
<tr>
<td>(unit: inch)</td>
<td>(unit: mm)</td>
</tr>
<tr>
<td>A6 (4.13 × 5.83)</td>
<td>5</td>
</tr>
<tr>
<td>A5 (5.83 × 8.27)</td>
<td>8</td>
</tr>
<tr>
<td>A4 (8.27 × 11.69)</td>
<td>11</td>
</tr>
<tr>
<td>A3 (11.69 × 16.54)</td>
<td>16</td>
</tr>
<tr>
<td>A2 (16.54 × 23.39)</td>
<td>23</td>
</tr>
<tr>
<td>A1 (23.39 × 33.11)</td>
<td>25*</td>
</tr>
</tbody>
</table>

Table 1
*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the previous setting will be applied.
Segmental Positioning

For precise cutting quality, it is suggested to select “Segmental Positioning” when you are working on an extra long or large-sized image to increase cutting accuracy.

- **X Step**: The distance of intermediate position on the X axis
- **Y Step**: The distance of intermediate position on the Y axis
  - Range: 200mm~600mm
  - Optimized Setting: Less than 500mm

The system will create the marks as shown in the picture below.
It is suggested to select “Multiple Copies” when you would like to make several copies of one image on your material to increase cutting accuracy.

### Multiple Copies

- **No. of X Copies:** The numbers of copies on X axis
- **No. of Y Copies:** The numbers of copies on Y axis
  - Range: 1~50. (The more copies you make, the more time is needed for data transmission.)
  - Numbers of X Copies * Numbers of Y Copies = The total amount of image copies
- **Copies with outline:** To show outlines of image graphics
- **Margin:** Space between marks; must be 0 or $\geq 20$, no negative numbers allowed

The system will create the as shown in the picture below.